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Excel 2013 Tips & Tricks 
 

 

This document will show you how to use Tools and Techniques in Excel 2013 that 

will increase your Excel productivity!   

Credit: This document is adapted mostly from a course by Dennis Taylor @ 

lynda.com  

 

Topics  

 Entering data more efficiently; 

 Using the Drop-down list; 

 Using the Fill handle; 

 Entering today's date or time instantly; 

 Enter data or formulas in non-adjacent cells simultaneously; 

 Converting formulas to values with a simple drag; 

 Data Clean-Up; 

 Adjust all or selected column widths or row heights in a flash; 

 Performing calculations without formulas; 

 Applying formatting with keyboard shortcuts; 

 Identify and eliminate duplicates; 

 Sort data with single buttons; 

 Clean up Spaces Quickly (trailing Spaces and Leading Spaces);  

 Identify and eliminate duplicates;  

 Using the Flash Fill; and 

 Using Excel's Autofilter feature to filter your list. 

 

 

 

 

 

 

http://www.lynda.com/Dennis-Taylor/574677-1.html
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Entering data more efficiently 

 

 Pressing (Alt+ Enter), forces a line break so that you can type additional 

data in the same cell below the other data. This is useful when a column 

doesn’t need to be very wide, but a long label will make it considerably wider. 

o For example, if you need to 

type in “2014 Tax Rate”, in 

cell B1, you type 2014 (Alt + 

Enter), then Tax, (Alt + 

Enter), then type Rate, and 

then Enter. 

Using a Drop-down list 

Suppose that some names in column A are going to be repeating, then instead of 

typing repeated entries, simply Right- click in the next cell and choose Pick from 

Drop-Down List and click the one you want and move on.  Remember, (Alt + 

down arrow) will activate the list as will Right – click, by way of Pick from Drop-

Down List (one of the AutoComplete feature in Excel).  
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Using the Fill Handle  

Instead of entering data manually on a worksheet, you can use the Auto Fill feature 

(Fill Handle) to fill cells with data that follows a pattern or that is based on data in 

other cells. 

 If you are creating a number series, such as 1010, 1020 …, for example.   

o Type the first two numbers. 

o Highlight the first two numbers, and drag from the Fill Handle as far 

as you need to.  

 Let’s type January in cell A1, and fill in the remaining cells below, by 

dragging the lower right-hand corner of A1, called Fill Handle, as far as you 

need this.  

 If you dragged it farther than December, the list will simply start all over 

again.  

 If you use all upper case, you'll get all upper case.  

 If you start with a three-letter abbreviation Jul in cell G1, for example and 

drag from the corner of the cell G1, you will simply get abbreviations for the 

various months.  

 And any time you drag downward or rightward, you move ahead 

chronologically as you use these different features.  

 If you drag upwards, from that lower right-hand corner, you go backward in 

time, or leftward.  Note: this technique works only with three-letter 

abbreviations or full spellings. Same thing is true with days of the week.  
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Entering Date or Time instantly  

 If you simply want to put in today's date quickly, Type (Ctrl + ;).  

 If you want to put in the date in such a way that it will adjust all the time, 

use =today(, and Enter. There is no need to type the right parenthesis. 

 Any time you drag a date entry that's simply a date, and drag from the 

Fill Handle, you automatically will get the next day, next day, and next 

day.  

 To type dates of seven-day interval:  

o Type the first two dates.  

o Highlight both of these dates.  

o Drag from the right lower corner of the cell (Fill Handle), as far as you 

need.  And of course, that could be a 14-day interval, a 10-day 

interval, or a four-day interval, as needed, based on the context that 

you need it for.  

o If you want to repeat the same data entry, you hold down the Control 

key, while dragging the Fill Handle (January in cells A2:A5).  

 

 

 

 

Instantly Entering Today's Date or Time 

 Press (Ctrl + ;) for today’s date. This date is “static” and will stay there 

indefinitely, until you put other data in there.  

 If you do want to enter today's date, so that it will adjust as you open and 

close the file, you want to put in the function =NOW(.   There is no need to 

type the right parenthesis.  This puts the date “dynamically”. So, as you 

open and close this file and save it, this date will get adjusted automatically. 
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 If you want to put in the current time, press (Ctrl + Shift + ;). If you would 

like that to be a dynamic entry (will change as you open and close files), type 

the =NOW(. Initially, this will put in date and time.  But with dates and 

date-like information, any time you drag an entry without doing anything 

special, you automatically get incrimination. 

Entering data or formulas in non-adjacent cells simultaneously 

 Anytime you need to copy information down a column, whether it be a formula 

or text or a value, it's nearly always more efficient to Double-click the Fill 

Handle (lower right hand corner of the selected cell) instead of either 

dragging the Fill Handle or using lengthy Edit -> Copy/Paste techniques.  

 Suppose that, in cell L2 of Employees Data, is a formula that's simply 

increasing the compensation amount from value in K2 by 3.73% (in cell N1) 

and here's the formula: =ROUND(K2*$N$1+K2,0) 

 To copy this down the column L, rather than dragging from the corner in cell 

L2, you'll simply double-click the lower right hand corner (Fill Handle) of the 

cell L2.  
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 To know "How far did this get copied?” press (CTRL+ period). Maybe 

scroll just a little bit more to confirm that it went to the bottom of your list. 

You can press (CTRL+ period) again to go back up top.  Over in columns Q 

and R, you've got similar kinds of data, but let's say you want to put in a 

month in cell R2.  

 Now, if you put in January, or JAN in cell R2, Excel recognizes this as a special 

kind of entry. You can double-click the lower right hand corner in cell R2 (Fill 

Handle), Excel simply fills this in with subsequent months.  

 If you had more numbers down in column Q, then after December, you would 

have seen January, February, March, all over again. However, if text in R2 is 

just pure text, you'll get the same text over and over again. This technique 

works with numbers as well as with text and also with formulas.  

 Suppose that you want to find a median for each of the states for a six month 

period for columns I though M. You also want to do the same in columns B 

through F. So using the CTRL key, you will highlight these cells (select 

columns I through M, then press the Ctrl key, and select columns B through F, 

from left to right). Makes no difference which order you highlight these in.  

Now type the formula that you want,  =median(B2:B7) and press (Ctrl + 

Enter) key.  Notice that as you type this, it looks as if you are typing this 

only for column B.  But instead of simply pressing Enter, you'll press (CTRL + 

Enter), and as you can see the same relative formula will go into all these 
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cells, using the median function, in every single one of these cells in the 

correct way.  

 

 

 

 

 

 

 

 

Data Clean Up  

Suppose that you have entries in column A of a worksheet that are all 

uppercase, and also some of the entries have leading spaces, or multiple 

embedded spaces, and you want to clean that up.    You will use functions 

'Proper' and also a function 'Trim', to clean up the data (as shown in cell B2).  

 Inset a column next to column A 

 In cell B2 type =TRIM(PROPER(A2)), and press the Enter key 

 Use the Fill Handle to copy the formula from cell B2 to the rest of the 

cells.  Appropriate letters are uppercased, and trim gets rid of the extra 

spaces.  Now you would like take these results in column B (values, not 

the formulas), and put them in column A.  
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 So, select values in column B (b2:b20), and with the 'right' mouse button, 

point to either the left edge, the top edge, or the right edge of the 

selected cells. 
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 Hold down the 'right' mouse button, and drag the selected cells into column 

A, using the 'Copy here as values only' from the short-cut menu. That's not 

a formula, it's the result that you actually saw over in B2, but no formulas are 

left here. Now you may delete column B. 
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You can also quickly do this by using the Paste Special option.  

Here's how:  

 Select cells that have the values you want to copy and press (Ctrl + C).  

 Click the upper-left cell of the paste area and press (Ctrl +Alt + V).  

 Pick Values (or press V), and then press Enter. 

 You may also copy values in cell (b2:b20), and then select cells (a2:a20) 

 Right-click, and select Paste Special -> Values. 
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Adjust all or selected column widths or row heights in a flash 

 

In this table, you can see that some of the columns are not wide enough (seeing 

pound signs when that columns are not wide enough). 

  

 

 

 

 

 

To adjust all of our columns at the same time rather than individually 

 Click in the upper-left corner of the worksheet (Select All) button, to select 

the entire worksheet. 

 Double-click any column separator between column letters. All of the columns 

are now a so-called "best fit."  

 You can also adjust row heights by selecting the entire worksheets (Select 

All), and then, double-click one of the row boundaries between row numbers.  

Select all 

Many people know the shortcut for "select all": Control + A. However, in Excel, 

this shortcut behaves differently in different contexts. If the cursor is in an empty 

cell, Control + A selects the entire worksheet. But if the cursor is in a group of 

contiguous cells, Control + A will select the entire group of cells instead. 

The behavior changes again when the cursor is in an Excel Table. The first time you 

use Control + A, the table data is selected. The second time, both the table data + 
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table header are selected. Finally, the third time you use Control + A, the entire 

worksheet is selected. 

Sort data with single buttons  

In Excel, you can sort data according to specific sort order rules. You can sort the 

number data as per ascending order and descending order. And, you can also sort 

the text according to alphabets A to Z or Z to A, in Microsoft Excel 2013.  This option 

is available in the Data Tab under the Sort & Filter group. 

Before sorting your data: 

 The Table should have only one header row. 

 Do not leave any empty cells in any cell of the header row. 

 Do not leave empty rows or columns in the data area. 

 Sort button (in Editing Group) is recommended if you only sort occasionally, 

sort on multiple layers, sort based on cell color, font color, or cell icon.  

 If you wish to sort your data, based on a single column, you don't need to 

select the data before you do sorting. Instead, select only a single cell. Then, 

clicking the Sort icon automatically sorts the entire List and the data will be sorted 

according to the selected cell’s field.  Remember NOT to click the column letter, 

you could be on the path to only rearranging the data in that column only, so 

click on a single cell. 

So suppose you want to sort the following table by Building within that by 

Department, and within that by Employee Name (Data tab -> Sort).  

Here is how it is done: 

 You'll sort the Employee Name first. Click in column A, do an AZ Sort. 

 Click in column C, do an AZ sort. 

  Click in column B, do an AZ Sort.  
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Note: The LAST Sort always overrides the previous ones. 
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Clean up Spaces Quickly (trailing Spaces and Leading Spaces)   

Spaces will cause problems, when you sort data. You also might have trailing 

spaces in some of the data that could cause problems if you're trying to set up some 

checks using the “if function” for example. Multiple Enter spaces might also cause 

problems.  

 

 

 

Usually what you need to do in these situations is to insert a new column to the right 

of the column you are working with.  And then, the function you want to use in the 

new inserted column to clean up the data is Trim(), one of the Text functions.  

Trim Function does three things.  It returns the data without leading spaces, 

without trailing spaces, and multiple consecutive inter spaces.  If you trim a cell, and 

press (Ctrl + Enter), the active cell does not move downward.  Then double click 

the lower right hand corner (Fill Handle), to copy this down the column.  

Identify and eliminate duplicates 

Duplicate records seem to be a fact of life these days as you look at this list here on 

a worksheet called 'HR List with Duplicates'. You probably already have seen rows 

10 and 11.  
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Those are duplicates. Adam Frost is in there twice. You need to get rid of that. You 

might also recognize, Juan Bishop, on rows 4 and 7.  

Usually when you sort data the duplicate records are going to come together because 

based on how you sort, you will expect that, but for whatever reason in this list they 

are not together.  

On the Data tab there is a command called 'remove duplicates'. But what if you 

really want to, at first, identify which records are duplicated? For example, in the 

following table, all you need to really say is, "If you have a duplicate social security 

number, you've got a problem."  

So let's just select column D and then on the 'Home' tab in the Ribbon, go to 

Conditional Formatting.  
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As you slide over the first choice, ‘Highlight Cell Rules’, the last entry on the right, 

Duplicate Values -> click OK.  Notice that some records have duplicate social 

security number.  

 

 

 

 

 

 

To Remove Duplicates 

 Click anywhere within the data, on Data tab, click Remove Duplicates. You 

probably don't have to check duplicates in every single column out. 

 Click OK.  
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Flash Fill 

One new addition to Excel 2013 is a feature called 'Flash Fill'. And on the 

following table, you cannot sort your list by last name, or by state, or by zip code.  

 

 

 

 

 

 Insert a new column to the right of column A.  

 Right click column B and Insert. Suppose that you want these names to 

appear in last name, first name order and, not capitalized.  

 Type Gomez with only the G capitalized. Comma, space, Eric, enter.  

 Now for the next name type Wagner, Max but you’ll just type the W and Excel 

recognizes the pattern already and you see this being displayed in the 

background in grey. Press Enter. All cleaned up with a few flaws. The B in 

O'Brien is not capitalized. And hyphenated names, Jessie Todd-Jones that 

comes out as Jessie, Jones. All the others are taken care of nicely.  

 Delete Column A after moving contact over to column B.  

 Now a different way to approach this, press Ctrl + Z again.  

o If you simply type in the name column B, and then go to Flash Fill 

immediately you get an answer. Now, the first cell is not quite what 

you want, but everything else is looking the same as it was.  
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Create chart titles from cell content 

Suppose that we have used the following data to create a 3D- Stacked Bar Chart. 

 

 

 

 

To add a Title to this chart: 

 Click the chart to activate the Design tab, the contextual tab that appears 

when you have charts selected, and the second button from the left is called 

Quick Layout.  As you drag over them, you see how various elements of 

charts appear. Chart Title appears on most of them at the top.  

Domestic Europe Asia Total

Jan 80 60 110 250

Feb 140 80 120 340

Mar 125 80 110 315

Apr 130 100 120 350

May 140 90 140 370

Jun 170 100 130 400

Jul 190 120 145 455

Aug 210 130 160 500

Sep 160 140 185 485

Oct 210 130 180 520

Nov 250 125 190 565

Dec 300 135 200 635

Total 2,105 1,290 1,790 5,185

World-wide Sales - Millions of Dollars
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 You might also want the legend to be explained down the left hand side, so 

you might pick one of the layout styles that provides you with title locations. 

Layout #9, for example, gives you a chart title placement on top and on 

the left side and below the chart you see access titles.  

 Choose that one, but let's not type actual titles here. Let's say for chart title 

it would be ideal to pick up the data that's in cell A1, the name of the 

company, and for the access title to explain those numbers, what you see in 

cell A2, worldwide sales millions of dollars, that would be ideal so let's 

not type them.  

 Click Chart Title, type =, Click cell A1, and press Enter. And for the access 

title, click that, type =, Click cell A2, and press Enter. You don't have any 

text for the title below this, maybe you don't need anything at all, you can 

just press Delete if you want, but the main idea here is you can easily bring 

in titles from existing worksheet data rather than typing in that information 

and it does accelerate the idea of how you quickly create charts to make 

them look the way you want.  

 One of the many tools available is that Quick Layout button, second button 

from the left on the Design tab, the tab that's present when you select a 

chart. 

How to Use Autofilter in Excel 

Autofilter is one of the most powerful features of Excel if you need to work with 

data in tabulated (table) format. It lets you treat a range of cells as a table and then 

filter out certain rows based on different criteria. It is very powerful if you need to 

"mine" data in a list and find out specific information about the data in that list.  

Prepare your data for Autofilter 

To use Autofilter, first ensure you have a table of data to work with. Follow these 

simple steps to check that your data table is ready to use with Autofilter: 

 Check that your data is organized in columns.  

 Each column should have a heading that explains what sort of data is in the 

column.  
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 Your column headings should occupy just one row of the spreadsheet, as 

shown in this example: 

 

 You should avoid using column headings in two rows, as shown in the 

following example, because they can confuse Excel's Autofilter feature and 

stop it working as it should. While you can still use Autofilter if you have 

headings in two rows as shown here, it's much easier if you stick to headings 

in just one row: 

 

 

 

 Next, make sure there are no empty columns or rows in your data. Excel is 

good at sensing the start and end of a data table by looking for empty rows 

and columns, and will ignore data after an empty row or column.  

 To check if your data is formatted in one contiguous range (a fancy way of 

saying "one block of data", which is used a lot in the Excel world) is to click a 

single cell in the table then press CTRL+* (or CTRL+SHIFT+8 if you don't 

have a separate number keypad). This automatically selects the whole table. 

You'll then see if you have any problems with the layout of your table. This 

example shows a table that is in a contiguous range: 
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 This table has an empty row; after pressing CTRL+* to select the table, you 

can see that the rows after the empty column have been ignored: 

 

 Similarly, this table has an empty column, so the columns to the right of the 

empty column have been ignored: 

 

 

 

 

 

 

Note that empty cells within the table are OK. What isn't OK is a whole row 

or a whole column of empty cells.  

 Finally, check that you have consistent data types in all cells.  

o For example, if you have a date column, make sure all the values in that 

column are dates (or blank). 

o If you have a quantity column, make sure all the values are numbers (or 

blank) and not words. 

o This is not a hard and fast rule, but it will make it much easier to use the 

features of Autofilter if you follow them wherever possible.  At this point, if 

everything is looking OK, you're ready to move on to the next step. 

 

Enable Autofilter 

Once your data range that meets the criteria above, you are ready to apply the 

Autofilter feature: 

 Select a cell in the range.  
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 Any cell will do, but make sure you don't select more than one cell or Excel 

will apply the Autofilter to the selected cells rather than the whole table. 

 You may prefer to select all of the cells in the data range if you want - this is 

a good idea if you have columns with headings in two or more rows (as 

discussed above). 

 Next, click the Sort and Autofilter button on the Home tab of the Excel 

ribbon toolbar, then click Filter. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The first row in the table (the header row) should change, with a small 

drop-down arrow on each cell in the header row, similar to the example 

below: 

 

Using Excel's Autofilter feature to filter your list 

You can now filter the table based on the values in the table by clicking the buttons 

to the right of the column heading. This will show a drop-down list as shown here: 

In this example, you've clicked the Autofilter button for the Salesperson. Based on 

the selection you have made, the list will be filtered to show only rows where Mike is 

the Salesperson. Other options you have here will allow the following: 



Excel 2013 Tips & Tricks Handout 

Heide Mansouri Technology Support ShortCourses Page 27 
Computing ShortCourse Coordinator                 IT Division                                                    10/19/2015                

Texas Tech University 

 Sorting by Salesperson. In this case the list could be sorted alphabetically in 

ascending (A to Z) or descending (Z to A) order.  

 If you are using Color formatting on the cells in the Salesperson column, you 

could also choose to sort by Color. This option also hides the very useful (and 

powerful) Custom Sort option which allows you to sort the list by multiple 

criteria, such as sorting by Salesperson and then by Item.  

 You could also select more than one salesperson from the list by checking the 

box next to the name of each salesperson you want to filter by. 

 Text Filters allow you to use various advanced text filtering options, rather than 

choosing specific people from the list. One example would be to filter by all 

salespeople whose name starts with M.  

 The Search option is useful when you have a large list of unique records (in this 

case that would mean lots of different salespeople), so the quickest way to find a 

specific person is to type their name, rather than scrolling through the whole list. 

This option was introduced in Excel 2010, and is also available in Excel 2011 for 

Mac and Excel 2013 for Windows.  

 Once you click OK with the selection above, the list will look like this: 

It is important to note two things about this list now that it has been filtered: 

1. There is a different filter icon at the top of the Salesperson column, indicating 

that this list has a filter applied on the Salesperson column. 

2. The row numbers are now shown in blue, indicating that the list has been filtered. 

Note how the row numbers now skip row numbers for rows that don't match the 

filter. 
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Using Autofilter to filter by more than one criteria 

The above example used just one criterion “Salesperson” to filter the list. However, 

you can filter by multiple criteria if you want. For example: 

 Show only rows that include sales by Mike, where he sold Washing Machines 

(filter by Salesperson=Mike and Item=Washing Machine) 

 Show only rows that include sales by Mike where he sold more than 10 units 

(filter by Salesperson=Mike and Quantity>10) 

 Show only rows that include sales of Refrigerators that were made on the 2nd, 

3rd or 4th of January. 

Once you start working with Autofilter, you will find it an excellent and powerful tool 

for filtering and mining data from your spreadsheets. The next lesson will cover more 

advanced filtering options, and will also show you how to perform calculations that 

change according to criteria you have used to filter the list. 

Ten Double-Click Tricks 
  
1. Skip the OK button: Unless you're clicking a checkbox, double-click on your 

choice within any dialog box in Excel to select that option and click OK 

simultaneously. For instance, press Ctrl-1 to display the Format Cells dialog box. 

Double-click on any format within the Number tab to apply the formatting and close 

the dialog box in one step.  

2. Maximize file windows: Double-click on the title bar of Excel's Open or Save As 

windows to see more files and folders. Double-click the title bar again to restore the 

default window size. You can double-click on Excel's title bar or a worksheet window 

as well. 

3. Split a worksheet: Double-click either of the split handles in Figure 1 to view 

two sections of the same worksheet at the same time. Double-click on a split to 

remove it. 

4. Fill handle: Just about everyone knows that you can grab the little black notch in 

the right-hand corner of a cell and drag down to fill a range of cells. Double-click this 

Fill Handle instead to copy data or formulas down until a blank cell is encountered in 

the adjacent column. In Excel 2010 and later, this feature copies down to the bottom 

of the contiguous block of cells, meaning it can skip past blanks in the immediately 

adjacent column. 



Excel 2013 Tips & Tricks Handout 

Heide Mansouri Technology Support ShortCourses Page 29 
Computing ShortCourse Coordinator                 IT Division                                                    10/19/2015                

Texas Tech University 

5. Lock the Format Painter: Most users click once on the Format Painter to 

transfer formatting from one cell or drawing an object to another. To apply the same 

formatting to a number of non-contiguous cells, double-click the Format Painter and 

then format as many cells as you wish. Press Escape once you finish with the Format 

Painter. 

6. Rename a worksheet tab: Although you can right-click on a worksheet tab and 

choose Rename, double-click the tab to immediately edit the name. 

7. Adjust column widths: Double-click the right edge of any column on the 

worksheet frame to automatically resize that column to fit the width of the longest 

cell entry. Or, select two or more columns and double-click the right edge of a 

column to resize multiple columns at once. 

8. Collapse the ribbon: Double-click any ribbon tab in Excel 2007 and later 

versions to collapse or expand the ribbon interface, thereby giving you more (or 

fewer) rows onscreen. 

9. Edit a cell: Double-click any worksheet cell to edit its contents in place rather 

than moving your mouse to the formula bar. 

10. Pivot Table Drill-Down: Double-click on any numeric value within a pivot table 

to create a new worksheet that reveals the underlying records that comprise that 

amount.  

 

Recommended Online Resources 

 Online Video Training Library http://library.ttu.edu/lynda  and 

www.CBT.ttu.edu   

 Safari Books Online http://library.ttu.edu/arch/collections/ebooks.php   

o 101 Excel 2013 Tips, Tricks and Timesavers By: John 

Walkenbach, July 1, 2013 

   

 

Please e-mail your questions, comments, or suggestions to heide.mansouri@ttu.edu. 

http://library.ttu.edu/lynda
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